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Clinical Case

35 y.o. patient presenting with a Glioblastoma Multiforme
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Glioblastoma Multiforme

e Glioblastoma Multiforme (GBM) is
a fast-growing high-grade primary
gliomas

* Current treatment options
combine surgery with
radiotherapy and chemotherapy

 GBM spreads to critical areas
associated with motor function,
language or vision
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GBM Surgery

* Brain tumor surgery aims to maximize
the extent of tumor resection while
preserving critical white matter fibers

_ = * Achieving complete resection in GBM
\  surgery is a challenge due to tumor
infiltration

Image courtesy of Dr. Alexandra Golby, Brigham and Women’s Hospital
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Diffusion MRI for brain surgery

e Diffusion MRI enables non-invasive
exploration of white matter
anatomy

* Tractography techniques can bring
clinically relevant information
during surgical planning of brain
tumor resection

Pujol S. Imaging White Matter Anatomy for Surgical Planning of Brain
Tumors. Image-Guided Neurosurgery, First Edition. A. Golby Ed.
Academic Press 2015
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Overall Objective

This tutorial provides an
end-to-end solution for
segmenting the contours of
a tumor and generating
white matter fiber tracts in
the vicinity of the lesion
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Disclaimer

e 3D Sliceris a free open source software for medical
image computing research distributed under a BDS
style license.

* The software is not FDA approved or CE-Marked, and
is for research use only.



Workflow Overiew

Step 1: Tumor Step 2: Fiber Tracts Step 3: Interactive
Segmentation Generation Exploration
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Image Processing Workflow

The image processing workflow described in this tutorial
uses three algorithms:

* Grow Cut algorithm for tumor segmentation
e Marching Cube algorithm for surface modeling

* Single tensor streamline tractography algorithm
for fiber tract generation



Overall Goal

This tutorial provides an
end-to-end solution for
segmenting the contours of
a tumor and generating
white matter fiber tracts in
the vicinity of the lesion




& Slicer
dMRI Part 1: Tutorial Materials

Installation
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Tutorial materials

* 3D Slicer release version 4.10 @

3DSlicer

* SlicerDMRI Extension diiss

* White Matter Exploration dataset i




3D Slicer installation

* Toinstall and start the 3D Slicer software on your
computer, follow the instructions of the Quick Start
Guide tutorial available at

https://www.slicer.org/wiki/Documentation/4.10/
Training

Windows Mac 0S X Linux
version 4.10.0 version 4.10.0 version 4.10.0
Stable Release evision 27501 evision 27501 L S

revision £/9V evision £/9U revision 27501
older releases built 2018-10-19 built 2018-11-01 built 2018-10-19

S.Pujol R.Kikinis - All Rights Reserved



Slicerv[_)I\/IR !n_stal

lation
&a Modules: . & Data \ i A E Ot -8
ox M1

o,

@ Sifcer Left click on the module Data to
 Help & Acknowledgement display the list of modules available
Subject hierarchy = Transform hierarchy  All nodes in 3D SliCer
Node - G

SRS 3S:0.000mm |~ Y& O———————— R:0.000mm |[wG# [ A: 0.000mm

v Show transforms = Show MRML ID's
» Subiect hierarchy item information
Filter:

» MBML node information
~ Data Probe

Green (L 32.0,A0.0,S15.7) Coronal Sp: 1.0

L None
F None
B None
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SlicerDMRI Installation

g3 Modules: . & Data : =R 'y A
All Modules ' —
(»ﬂ\ 2 Annotations f
L3 Slicer % Data
DataStore
» Help & Acknowledgement | s« picOM
: : Markups
Subject hierarchy = Transfa © Models

Node » Scene Views

« Segment Editor

% Segmentations

@ Transforms

M View Controllers

@ Volume Rendering

@ Volumes

& Welcome to Slicer
Wizards ’
Informatics S F > S: 0.000mm
Registration
Segmentation
Quantification

- Y#% ——————R:0.000mm [*G# (—————A:0.000mm

| Diffusion »  Install USit
Filtering Import and Export
v Show transforms . Show | g, tace Models Utilities
» Subiect hierarchv item info 5, verters
Filter: Endoscopy
’ I\[/;Fitr\/ll_Pno:e information Utilities
= Lala riobe Developer Tools : : . g
VT s Select the category D_|ffu§|on in the ||§t of modules
: Testing Select Install Slicer Diffusion Tools (SlicerDMRI)
¢ MultiVolume Support
B
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S||cerDI\/I‘RI Instal ation

i @ Modules: & Install Slicer Diffusion Tools (SlicerDMRI) ~ —' ‘ (= .ﬁ © & K 42 4 t- B 4 Y - E a

5

@ DSlicer

» Help & Acknowledgement

The SlicerDMRI extension provides diffusion-related tools including:
» Diffusion Tensor Estimation
« Tractography Display
» Tractography Seeding
« Fiber Tract Measurement

For more information, please visit:
http://dmri.slicer.org
Questions are welcome on the Slicer forum:

https://discourse.slicer.org

gxnszau SlicerDMRI

Click on Install SlicerDMRI

~ Data Probe

Show Zoomed Slice

-n
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SI|cerDI\/I‘RI Instal ation

Modules: «% Install Slicer Diffusion Tools (SlicerDMRI) ~ == (= @ Q & 5 72 4 t - B e S % B =

@ DSlicer

» Help & Acknowledgement

B’

The SlicerDMRI extension provides diffusion-related tools including:

« Diffusion Tensor Estimation
« Tractography Display

» Tractography Seeding

« Fiber Tract Measurement

For more information, please visit: 24 SlicerDMRI depends on the following
8 7 extensions:
http://dmri.slicer.org
« UKFTractography
Questions are welcome on the Slicer forum:
Would you like to install them now?
https://discourse.slicer.org

glnszau SlicerDMRI T

This tutorial does not use UKFTractography
Click on No

~ Data Probe

Show Zoomed Slice

-n
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S||cerDI\/I RI Instal ahon

@ (‘-) % Z éi b E e .:.lihv \¢ B "

= R 5

Modules: % Install Slicer Diffusion Tools (SlicerDMRI) ~

B’

@ DSlicer

» Help & Acknowledgement

The SlicerDMRI extension provides diffusion-related tools including:

« Diffusion Tensor Estimation
« Tractography Display

» Tractography Seeding

« Fiber Tract Measurement

For more information, please visit:
9 Restart to complete SlicerDMRI installation?

http://dmri.slicer.org
Don't show this message again and always OK

Questions are welcome on the Slicer forum:
Cancel |OK

https://discourse.slicer.org

glnszau SlicerDMRI

Click on OK and restart Slicer

~ Data Probe

Show Zoomed Slice

-n

B
ohts Reserved 2011-2019



E

#Y 3psiicer

4

Modules:

SlicerDMRI Installahon

% Welcome to Slicer
All Modules

£ Annotations
Data

~ DataStore

&4 DICOM

Welcor_ ==

¢ Models
5 Scene Views

(5 Load DICOM D 4 Segment Editor

&3 Install Slicer Extens

% Segmentations
| 4= Transforms

i+ Customize Slice M View Controllers

~ Feedback

@ Volume Rendering
@& Volumes
&) Welcome to Slicer

Share your stories w ;
" has enabled your res Wikards

We are always interested in impi

Informatics
Registration

report, open Help -> Report a Bu Segmentation

» About

» Documentation & Tutorials

» Acknowledgment

~ Data Probe

Show Zoomed Slice

-n

Quantification

Import and Export

Filtering

Surface Models
Converters
Endoscopy

Utilities

Developer Tools
Legacy

MultiVolume Support

- f;_%;.y@ég.// t- B iR -8

Load Data
ad Sample Data
? Loaded Data

I Select the category Diffusion in the list of modules
: Right-Click on Diffusion to access the different
“poviemor sl fynctionalities of the SlicerDMRI module

» Process

> Quantify

» Tractography
> Utilities

ohts Reserved 2011-2019



Tutorial Data

e The tutorial data include a baseline volume
and a diffusion tensor imaging (DTI) volume
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i Data

@ Modules:
)
e 4

» Help & Acknowledgement

B¢

Slicer

Subject hierarchy
Node

Transform hierarchy

Show MRML ID's
» Subject hierarchy item information

v Show transforms

Filter:
» MRML node information
~ Data Probe

Show Zoomed Slice

-n

Tutorial

All nodes

T "::_,1_;%

Data

Loa

<t b.

oling

- 3

Name

WhiteMatterExplorationData

Hl = [l

@ BaselineVolume.nrrd

v »

R DTIVolume.nrrd

Drag and drop the files
= BaselineVolume.nrrd and pusems
DTIVolume.nrrd into the
Slicer window
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Tutoria

@ Modules: i Data v i )

ta Loading

v E O] b. >

T Fn_.ﬁ

m Clirar
- Add data into the scene

2 Choose Directory to Add Choose File(s) to Add
v File

Subjet 'y /Users/kauai/Downloads/WhiteMatterExplorationData/BaselineVolume.nrrd

» Hel

Hod® v /Users/kauai/Downloads/WhiteMatterExplorationData/DTIVolume.nrrd

Reset

v Show transforms ~ Show MRML ID's
» Subject hierarchy item information
Filter:

» MRML node information

~ Data Probe

Show Zoomed Slice

-n

Show Options

Description
Volume -
Volume v

> R: 0.000mm | G 5

Click on OK to load
the files in Slicer

B
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-

Tutorial Data Loading
& Modues: & Data v'x;—{y;)' o t- Bk +- @4

(.;{: Slicer
=

» Help & Acknowledgement

Subject hierarchy  Transform hierarchy  All nodes

Node
@ BaselineVolume

fiF
a
___DTlVolume S

Slicer displays the DTl volume and the
baseline image in the background viewer

5 S: 58.741mm |« Y # e=————={}———> R:3.427mm B C e ——— A: 26.278mm

v Show transforms  Show MRML ID's
» Subject hierarchy item information
-ilter:

» MRML node information

~ Data Probe

Show Zoomed Slice

-n

S.Pujol R.Kikinis - All Rights Reserved 2011-2019



-

Tutorial Data Loading
& Modues: & Data v'x;—{y;)' o t- Bk +- @4

(.;{: Slicer
=

» Help & Acknowledgement

Subject hierarchy  Transform hierarchy  All nodes

Node
@ BaselineVolume

fiF
a
___DTlVolume S

Slicer displays the DTl volume and the
baseline image in the background viewer

5 S: 58.741mm |« Y # e=————={}———> R:3.427mm B C e ——— A: 26.278mm

v Show transforms  Show MRML ID's
» Subject hierarchy item information
-ilter:

» MRML node information

~ Data Probe

Show Zoomed Slice

-n
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Tutorial Data Loading

B® Modules: i Data t- @5 L

B¢

T "::_,1_;%

'{9 Slicer

» Help & Acknowledgement

Subject hierarchy ~ Transform hierarchy  All nodes
Node b |
@ DTIVolume &

Click on the eye icon next to BaselineVolume
in the Data module to display the baseline
image in the background viewer

5'S: 58.741mm |~ Y @& #:v R: 3.427mm = G E

v Show transforms ~ Show MRML ID's
» Subject hierarchy item information
Filter:

» MRML node information

~ Data Probe

| Red (L12.4,A53.3,558.7) Axial Sp: 2.6

L None
F None
B BaselineVolume (143, 100, 25)524

S.Pujol R.Kikinis - All Rights Reseryed 2011-2019
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Tutorial Data Loading
82 & & Modules: - |k Data =QQ 4k H t- Bmn +- @

Conventional
(.‘\ Slicer
o

[E8 Conventional Widescreen
» Help & Acknowledgement

[&l Conventional Quantitative N>
Four-Up

Four-Up Table

[# Four-Up Quantitative »

Subject hierarchy ~ Transform hierarchy  All nodes [ Dual 3D

Node e [E] Triple 3D
BaselineVolume e 3D only
& DTIVolume & [#] 3D Table

[T] Green slice only

Click on the Layout menu and

. | [ Tabbed 3D
select the layout Red Slice only | [ Tabbed sice »
| E§ Compare N
[T] Compare Widescreen »
FH Compare Grid » |

Three over three Quantitative
[l Four over four
B Two over two
[T] Side by side
[ Four by three slice
| il Four by two slice

E# Three by three slice
v Show transforms ~ Show MRML ID's

» Subject hierarchy item information
Filter:

» MRML node information

~ Data Probe

Show Zoomed Slice

m

e
8 i Lt
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@ @ @ Modules: i Data

Tutorial Data Loading

t v B ) 'b. . il

@ )Slicer

» Help & Acknowledgement

,
Subject hierarchy  Transform hiera S||Cer d|Sp|ayS a Zoomed V|eW Of \
Node g .
the baseline volume. P

@ DTIVolume Ed )

-
v Show transforms ~ Show MRML ID's
» Subject hierarchy item information | S
Filter:
» MRML node information

~ Data Probe

4 v

| Red (L72.6,A458,558.7) Axial Sp: 2.6 v |

L None
F None
B BaselineVolume (203, 108, 25)55

"N e
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Part 1:
Segmentation

of tumor and
ventricles




Tumor segmentation

Solid part This section shows how to segment
the solid and cystic components of
the tumor using the Grow from
Seeds tool of the Segment Editor
module.

The section includes the
segmentation of the lateral
ventricles for anatomical reference.

Lateral
Ventricles
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Segment Editor Module

* Segmentation is the process of identifying a
structure of interest in imaging data

 The Segment Editor module of 3D Slicer
provides powerful tools for manual and semi-
automated segmentation



{D 3iDSlicer

» Help & Acknowledgement

~ Reload & Test

Reload

Reload and Test

Empty segmentation
- Color

Basic Principle

Edit

Restart Slicer

o Segmentations... ~

The Segment Editor
module takes a reference
image (Master Volume) as
input and produces a
segmented image
(Segmentation) in output



Basic Principle

Master Volume Segmentation Master Volume +
Segmentation

The Segmentation volume is a binary labelmap with the
same origin and resolution as the Master Volume



Segment Ed] tor

@ @ Modules: % Data ) _ i Ky D t - @ M Y v
All Modules ’ 5% — ®— TR
£ Annotations

B osiicer =it Left click on Data to display the list

~ DataStore
= DICOM 1
» Help & Acknowledgement Dico Of Sl Icer mOd U|eS
Markups
© Models
% Scene Views

Subject hierarchy  Transform h
Node

 egne B m= Select the Segment Editor module

& DTIVolume @ Segmentations

» Segmanaten e Tcaiorae " in the Segmentation category

[ View Controllers
@ Volume Rendering

& Volumes

&3 Welcome to Slicer
Wizards >
Informatics »

Registration

Quantification

% Simple Region Growing Segmentation

Diffusion » Specialized
Filtering ’
Surface Models »
Converters >
Endoscopy »
Utilities »
Developer Tools »
v Show transforms = Show MR | egacy N
» Subject hierarchy item informati  Testing »
Filter: MultiVolume Support >

» MRML node information
~ Data Probe

Show Zoomed Slice

m
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B DSlicer

» Help & Acknowledgement

Segmentation:  Segmentation
Master volume: BaselineVolume
gp Add =

Empty segmentation
- Color

Effects

None

B4l

~ Data Probe

| Red (R 87.9,A95.2,561.3)

L None
F None

B BaselineVolume (42, 58, 26) 1

Tumor Segmentahon

@ Modules: 4 Segment Editor

Name

"
=

Axial Sp: 2.6

Select the Master volume
BaselineVolume

& sejretttons.. |- Slicer creates a segmentation
volume called Segmentation

B: BaselineVolume
is - All Rights Reserved 2011-2019
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Tumor Segmentahon

Modules: 4 Segment Editor ) E9P O % X 4 & % - @ e Fa = G 2

]3]

s iDSlicer 0
D - Click on Add to create two
» Help & Acknowledgement segments for the solid and cystic
Segmentation: = Segmentation com ponent Of the tumor
Master volume:  BaselineVolume v
dp Add @ Show3D - @) Segmentations... |~
Color Name
- Solid

Cysnc

ﬂ-
Click on Add to include a third

segment called Other for the

Efects background
x v« ®] o B B
None Paint Draw Erase | Level tracing = Grow from seeds Fill between slices
= ik o = P4 ] th

Threshold = Margin | Hollow = Smoothing = Scissors = Islands | Logical operators

Undo
~ Data Probe

Show Zoomed Slice

L
F
B B: BaselineVolume
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Tumor Segmentahon

Modules: 4 Segment Editor ] E— @ QD & 5 72 4 D, t v B W= R - g o2

»

E 3DSlicer

Segmentation: | Segmentation

Master volume: | BaselineVolume

3 Add = Se'Iect the segment Solid

Name

Select the Paint tool and draw a mark
in the solid component of the tumor

% in three contiguous slices
e\ Praw | Erase || Level tracing || arow nuim seeus rill UEWEEI T SILES
2 2 g oo &

Threshold || Margin || Smoothing || Scissors || Islands || Logical operators
Paint

Effects

Paint with a round brush... Show details.

Diameter: 3% $1111(3][5]10 ][ 20 || 40 || %
Sphere brush Color smudge Pixel mode
Undo Redo

» Data Probe

B: BaselineVolume



Tumor Segmentahon

Modules: 4 Segment Editor ) }ié— V O & 4 A D, t v B W= R - G =
E 3DSlicer

Segmentation: | Segmentation

Master volume: | BaselineVolume

& Add = Se'Iect the segment Cystic

Color

Name

= Bl Other

Select the Paint tool and draw a mark
in the cystic component of the tumor

Effects /
v\ % in three contiguous slices

None raw | Erase || Level tracing || arow nuim seeus rill UEIWEEI SICES

= £ ™ o B
Threshold || Margin || Smoothing || Scissors || Islands || Logical operators
Paint

Paint with a round brush... Show details.

Diameter: 3% $1111(3][5]10 ][ 20 || 40 || %
Sphere brush Color smudge Pixel mode
Undo Redo

» Data Probe

B: BaselineVolume



Tumor Segmentahon

@ Modules: 4 Segment Editor $| . Q ) 'Ei,— Q 4 VA t - B & Ib v g =
#3 zpsiicer
g

Segmentation: | Segmentation

Master volume: | BaselineVolume

3 Add —remoe Otlect the segment Other
Color Name
- Solid
Cystlc

Select the Paint tool and draw

Efects / a line around the solid and
v\ % cystic component of the tumor
Noné Jraw Erase Level tl’aCiﬂg GIUW 1HUITT DTTUD

i yTuwwecoti Snuves
2 & | & X &

Threshold || Margin | Smoothing || Scissors || Islands || Logical operators

Erase

Erase fom current segment with a round brush... Show details.

Diameter: 3% +/1]/3]/5/[10]/ 20| 40 || %
Sphere brush Color smudge Pixel mode
Undo Redo

» Data Probe

B: BaselineVolume



Tumor Segmentation
B8 || Moduies: , [ 4 Segment Editor = QOIEPO® & & < 4|HIt-8 =+~ 1@

&k Add = Remove @ Show 3D = (;) Segmentations...

Color Name

Select the Grow From Seeds
tool and click on Initialize

"

Effects
R 4 A 7] &)

None || Paint | Draw || Erase || Level tracing

: - A5 = o ] G

Threshold || Margin || Smoothing || Scissors || Islands || Logical operators

i &

Grow from seeds Fill between slices

Grow from seeds
Growing segments to create complete segmentation... Show details.

Preview: Auto-update Initialize
Display: inputs results
Cancel Apply
Undo 7 " Redo
¥ Masking
Editable area: Everywhere =

-

> Daia Prober 7 B: BaselineVolume




Grow from Seeds Algorithm

 The Grow from Seeds tool
implements the Grow Cut algorithm,
a competitive region growing
algorithm using a Cellular Automata
approach.

* The algorithm performs automated
multi-label image segmentation
using a set of user input scribbles.

Reference: Vezhnevets V, Konouchine V. "Grow-Cut" -
Interactive Multi-Label N-D Image Segmentation". Proc.
Graphicon. 2005 .pp. 150-156.



Tumor Segmentatlon

Modules: "4 Segment Editor - D || EE @ Q @& 5 7 4 D, t v B e :b - E o2
e I8

g

(B\ DSlicer

4
4} Add == Remove # Show 3D = 7@ Segmentations... m—
Color Name
> Solid

Slicer displays a preview of
the segmentation result

Effects
R || 4| ® A B
None || Paint | Draw | Erase | Level tracing || Grow from seeds Fill between slices
= A5 ™ ao i &

Threshold || Margin | Smoothing || Scissors || Islands || Logical operators

Grow from seeds
Growing segments to create complete segmentation... Show details.

Preview: v Auto-update Update
Display: inputs « results
Cancel Apply
Undo f " Redo
¥ Masking
Editable area: Everywhere =
> DartaVProber T B: BaselineVolume



Tumor Segmentatlon

Modules: "4 Segment Editor & D | E @ Q @& 5 7 4 D, t - B 4 :b v E o2
o x B
(B\ DSlicer
&
4} Add == Remove # Show 3D = 7@ Segmentations... m—
Color Name
s Solid

Effects
R s || 4 Lz A E
None || Paint | Draw | Erase | Level tracing || Grow from seeds o
2 & | = X | = 5 Click on Apply to create

Threshold || Margin | Smoothing | Scissors || Islands || Logical o]

the segmentation

Grow from seeds
Growing segments to create complete segmentation... Show details.

Preview: v Auto-update Update
Display: inputs « / results
Cancel Apply

Undo [ " Redo

¥ Masking

49

Editable area: Everywhere

' » Data Prober T B: BaselineVolume



Tumor Segmentatlon

@ Modules: /SegmentEdltor s ) || EE @ Q @& 5 7 4 D. t - B e :b v B =
&) %)
[ DS licer
&
| 5p Add == Remove @ Show 3D v bSegmentations... :5‘
. Color Name
= [l Sold

Cyshc

Effects
R s || 4 % y B
None || Paint | Draw | Erase | Level tracing || Grow from seeds Fill between slices
= A5 ™ o &

Threshold || Margin | Smoothing || Scissors || Islands || Logical operators

Grow from seeds

Growing segments to create complete segmentation... Show details.
Preview: || Auto-update
Display: inputs «

Initialize

results

Cancel Apply

\- Undo » Redo
¥ Masking

: | Slicer displays the segmentation result
Editable area: Everywhere

-t s

' » Data Probe

49

B: BaselineVolume




f@ @ Modules:

@ Slicer

Color
- Solid
Cystic

ulil

Effects
R || &

None Paint Draw Erase

(=]

< = ik D 5 g% &
Threshold bargin Hollow = Smoothing = Scissors Islands = Logical operators

Threshold

Fill segment based on master volume intensity range... Show ¢

Threshold Range:

Level tracing = Grow from seeds

Tumor Segmentahon

B = S -

- =0 Q.

4 Segment Editor

@Ef.

Name -

Select the segment Other

o /am
& e i 5
Fill between slices

& & &

Select the Threshold tool and set

1700.00 = —
the Threshold Range to 1700
Automatic threshold: auto->maximum ~ Otsu “T<]~ ST
USI |. Iikini
Undo Redo
~ Masking
o freiee - Set the Editable area to

Editable intensity range:

Overwrite other segments:

» Data Probe

Everywhere
Inside all segments
In‘;s'nde all V|S|ble se ments

Outside all v151ble segments
Inside Solid

Inside Cystic

Inside Other

Outside all Segments
and click on Apply



Ventricles Segmentahon

@ @ Modules: £ Segment Editor v | - O O e Ky Ha Sa, ¥

@ Slicer

» Help & Acknowledgement

~ Reload & Test

Reload Reload and Test Edit Restart Slicer
Segmentation: Segmentation v
Master volume: BaselineVolume v

&l Add == Remove @ Show 3D Q) Segmentations... |~
Color Name
e Solid
Cystic

I
Select the Islands tool

Effects Select the option
R 4| ® A E :
None Paint Draw Erase Level[;r]acing Grow fr': geds Fill betwet Keep seIeCtEd ISIand

- & | @
Threshold = Margin  Hollow = Smoothing = Scissor:

Logical operators

Islands
Edit islands (con'nected components) in a segment. : Le.ﬁ:_cl |C k on th e poste rl or
Keep largest island .o Keep selected island
Remove small islands Rem-ove Selected island part of the lateral ventricles
Split islands to segments Add selected island . .
to isolate the island

» Data Probe
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Ventricles Segmentahon

@ & Modules: 4 Segment Editor -|=-0 QO = D t - B S 5 -
r‘\ Slicer

=4

» Help & Acknowledgement -

~ Reload & Test

Reload Reload and Test Edit Restart Slicer
Segmentation: = Segmentation v
Master volume: BaselineVolume v

&} Add == Remove § Show 3D - O Segmentations...  ~
- Color Name

Double click on the segment Other
and rename it Ventricles

’
-
Effects v ..
R[4 ® 0 # &  * -
None Paint Draw Erase Leveltracing Grow from seeds Fill between slices ’ , .
v -w
- ' -

= & e ] & i3 &
Threshold = Margin  Hollow = Smoothing = Scissors Islands = Logical operators

™

Islands

- . % e
Edit islands (connected components) in a segment. .

Keep largest island o Keep selected island

Remove small islands Remove selected island

Split islands to segments Add selected island

» Data Probe .
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Ventricles Segmentahon

@ & Modules: 4 Segment Editor -|=-0 QO = D L - B e 5 -
r‘\ Slicer

=4

» Help & Acknowledgement -

~ Reload & Test

Reload Relnad and Test Fdit Restart Slicer

segmentation: - segmer - Click on the color icon next to the Ventricles

Master volume: Baselin

v segment : a pop-up window appears

- Color Name
ES Solid
- Cysnc Segmentation category and type - 3D Slicer General Anatomy list
Category. | . Ventricle |
Tissue Brain ventricle
Anatomical Structure Fourth ventricle
Physical object Lateral ventricle I
Morphologically Altered Structure Left Ventricle
Effects P oY
x5 Body Substance Right Ventricle
R(|&| 4| ® £ i Y J
None Paint Draw Erase Leveltracing Grow from seeds
Threshold = Margin  Hollow @ Smoothing Scissors Islands Logicé
Islands Name: Ventricles | Color: 'm |+
Edit islands (connected components) in a segment. Select
Keep largest island o Keep selected island
Remove small islands Remove selected island
Split islands to segments Add selected island

» Data Probe

Il Rights Reserved 2011-



Tumor and Ventricles Segmentahon

@ ‘ & Modules: 4 Segment Editor ™0 QO Ak A D t - @ fe S

8 Select the Category Anatomical Structure,
»Help & Acknowledgement enter the structure Ventricle, select Brain

- Reload & Test Ventricle and click on Select to change the

5'S: 58.741mm

Reload Reload and Test Edit Restart Slicer .
Secuiaiiiich [Eagmammion . Ventricles segment color to blue
Master volume: BaselineVolume v ~
&} Add == Remove § Show 3D - O Segmentations...  ~ ’ p
Color Name & ®

- Solid Segmentation category and type - 3D Slicer G natomy list v || & =4
i
uumm il g e g '
Tissue Brain ventricle <—

’ Fourth ventricle

Lateral ventricle

»
Morphologically Altered Structure Left Ventricle
Effects Body Substance Right Ventricle
R 4| B B £
None Paint Draw Erase Leveltracing Grow from seeds Fill betw
g ﬁ} e ix‘i_! a0 @ QJ

Threshold = Margin  Hollow = Smoothing = Scissors Islands = Logical operators

€€

Name: Ventricles «| Color: MW |«

Islands

Edit islands (connected components) in a segment.

Keep largest island o Keep selected island
Remove small islands Remove selected island
Split islands to segments Add selected island

» Data Probe
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Tumor and Ventricles

@ & Modules: -|=-0 QO A B t-

Segmentation

B M 5 - B

4 Segment Editor

(.‘\ Slicer

3

¢ Conventional

&l Conventional Quantitative

7 Four-Up
’ A Four-Up Table
Master volume: BaselineVolume v B Four-Up Quantitative
4p Add == Remove @ Show3D ~ O Segmentations... ~ [ Dual 3D S e | e Ct t h e CO nve ntl ONna I
- Color ame [ Triple 3D

- Solid
= [l Ventricles

Click on Show 3D

3D only

[#] 3D Table

[z One-Up Quantitative
[ Red slice only

[ Yellow slice only

[T] Green slice only

Tabbed 3D
[F Tabbed slice
Effects 8 Compare
— [T] Compare Widescreen
[ i
R z || 4 o & e ] FH Compare Grid
None Paint Draw Erase Level tracing Grow from seeds [ Three over three
B = = i L i o Three over three Quantitative
Fill between slices = Threshold = Margin = Hollow = Smoothing Scissors [l Four over four
5 By [ Two over two
Islands = Logical operators Il Side by side
[l Four by three slice
Margin [ Four by two slice
Grow or shrink selected segment by specified margin size. EH Three by three slice
Operation: Shrink
o Grow

Margin size: 3.0mm < 3x3x1 pixels

Apply
Undo Redo
~ Masking
Editable area: Everywhere

» Data Probe

jol R.Kik

1is - All Rights R

Widescreen view from

the layout menu




Tumor and Ventricles Segmentation

@ @ Modules: 4 Segment Editor v —_ O O 20N A B = rb v G
5% B 1 E8

¥ R e 1——7'S:56.141imm

) 3¢

@ Slicer .

The 3D viewer shows 3D surface models of ’
B . \ )
the tumor and lateral ventricles g

» Help & Acknowledgement

~ Reload & Test

o ]
Reload Reload and Test Edit Restart Slicer ' v ,’
L |
Segmentation: Segmentation v & —~— /
Master volume: BaselineVolume v | & @ ‘v ..
&p Add == Remove @ Show3D ~ o Segmentations...  ~
Color Name — ) R: -11.598mm
- Solid ay
- Cystic - L w
| o | |Ventricles |

Click on Segmentations to access the
Segmentation module

Effects
—
R 7 || 4 (7] B s £ » - = G e ——A: 31.278mm
None Paint Draw Erase Level tracing Grow from seeds -
= = & i 5
Fill between slices = Threshold = Margin = Hollow = Smoothing Scissors
Islands = Logical operators
Undo Redo

» Data Probe



Part 2: Peritumoral
volume generation
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Tumor and Ventricles Segmentahon

a @ Modules: @ Segmentations v | = \) ‘) * Ra . t - B M 4, -
60 1 BB
m Slicer
7
Active segmentation:  Segmentation v la
Source geometry:  BaselineVolume
g Add segment == Remove selected /. Edit selected
Color Opacity Name A
- 1.00 Solid
- 1.00 Cystic
~ Display
Overall visibility: v
Visibility Opacity
Slice fill: v 050 2
Slice outline: 1.00 <
3D: v 1.00 <
» Advanced

~ Representations
Binary labelmap
«" Closed surface Update . Make master

Fractional labelmap | Create _ In the Export/import models and labelmaps section
select the Operation Export and select the Output et 2romn
type Models

» Copy/move segments

~ Export/import models and eieime

Operation: Import

Output type: Labelmap

Output node: Export to new model hlerarch v

» Advanced - il Y S— .
Szl"eﬁé"ﬁu??é'n‘?'&%‘;‘fﬁﬂ?:::iﬁ;“y <+—— Set the output node to Export to new model hierarchy

-

» Export to files

» Data Probe




Tumor and Ventricles Segmentahon

@ “ @ Modules: % Segmentations v | w— \) ‘) 2 . t - B A 28 -
o 1% i ‘@’

| S

[ Slicer
e 4
Active segmentation:  Segmentation v |a
Source geometry:  BaselineVolume
5 Add segment == Remove selected /. Edit selected
Color Opacity Name o
E 1.00 Solid
o 1.00 Cystic
~ Display
Overall visibility: v
Visibility Opacity
Slice fill: v 050 2
Slice outline: 1.00 <
3D: v 1.00 |+
» Advanced

~ Representations
Binary labelmap

« Closed surface Update _ Make master
Fractional labelmap = Create _

» Copy/move segments

~ Export/import models and labelmaps

Operation: e Export Import
Output type: Labelmap e Models
Output node: Segmentation-models -
» Advanced
Export 4_

» Export to files

» Data Probe



Tumor and Ventricles Segmentahon

Ba 2 & Modules: @ Models -|- 0 QO o EHl t- B i .

— -

@ Slicer \ Select the module Models -

Include Fibers Scroll to Cr | | \

~ Scene
~ Segmentation-models
Solid 1.00

Vst

Ventncles M 1.00

Click on the eye icon to turn off the
+ iformation visibility of the models Solid and Ventricles

~ Display

~ Visibility

Visible: v

View: All v
Color: #{1d691

~ 3D Display

Opacity: 1.00 |3
Representation: Surface »

Visible Sides: | Front-facing -
Clipping: Configure...
» Advanced
~ Slice Display
Visible:
Opacity: 1.00
Mode: Intersection
Line Width: 1 px
Color Table:

| 4]

» Data Probe



Peritumoral volume generation
. BF T :

&R Modules: 4 Segment Editor =0 QO Ak A t- B w5
3 E 1 # S —
s - __-\‘-\’
@ Sy \ Select the module

Segmentation: | Segmentation Seg me nt Ed |t0 r

Master volume: BaselineVolume

g Add == Remove @ show3D ~ {)Segmentations.‘. v
Color Name
- Solid
[ - (W [Cy -
» B .
Select the segment Cystic
Effects
R s % | My
None Pg rase = Level tracing Grow from seeds
Fill between slices ' Threshold = Margin = Hollow = Smoothing Scissors

L [ Select the tool Margin
slanas ogica operators
Margin and the operation Grow

Grow or shrink selected seiment by specified margin size.

o e Click on Apply 3 times to
Operation: Shrink
® Grow / dilate the segment Cystic

Margin size: 3.0mm + 3x3x1 pixels
Apply
Undo Redo
~ Masking
FAditahla araa- Fyvanaa hara £

» Data Probe



Perltumora\ volume generahon

B2 B &3 Modules: 4 Segment Editor |- O @ O t- B = & -
(.‘\ Slicer
= 4

hﬂll‘\\l\l _— TV e w - W vw > V WOYIISIIAUVHID. A

Color Name

Solid

n%lm_ The segment Cystic has
been dilated three times

Effects
A
R 4 A % &) .
None Paint Draw Erase Level tracing Grow from seeds
B= = ok ‘i; a6

Fill between slices ~ Thre

& % Inthe next section, we
M';" rseaioree \will use the dilated
Grow or shrink selected s¢ CyStIC Segment tO SEEd

Operation: Shrink

.aow TiDer tracts

Margin size: 3.0mm + | 3x3x1 pixels
Apply
Undo
~ Masking
Editable area: Everywhere -

Editable intensity range:

Overwrite other segments: All segments -
» Data Probe
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Perltumora\ vo\ume generahon

@ ‘ @ Modules: 4 Segment Editor - ! > : . t- B w5 -

B B o R F———5:56.141imm
(i\ )Slicer
> 4

» Help & Acknowledgement

~ Reload & Test

Reload Reload and Test Edit Restart Slicer
Segmentation:  Segmentation - Re name th e Seg me nt Cystic
Master volume: BaselineVolume v i . . ’ .
& Add == Remove @ Show3D ~ 0 Segmentations...  ~ ' CyStl C-Dl lated an d Cl l Ck on "’ W
B s Nere Segmentations to access the : = LI
u[i.vm.c.es Segmentations module -
»
)
=
Effects A: 31.278mm
g 4 A % &) -:!!
None Paint Draw Erase Leveltracing Grow from seeds
= = & ™ &
Fill between slices = Threshold =~ Margin = Hollow = Smoothing Scissors

~ Data Probe: /Use_r_s/spuon/Dropbox/or...2019-01-12-Scene.mrml

| Red (L42.1,A93.4,556.1) Axial Sp: 2.6

L None
F None
B BaselineVolume (172, 60, 24) 1083




Perltumora\ vo\ume generahon

@ @ @ Modules: % Segmentations v &) A it Fa - % -~ B A *b -
B B ; e 556 141mm
. DSlicer
= 4
Active segmentation: ' Segmentation v |a
Source geometry:  BaselineVolume
5 Add segment == Remove selected /. Edit selected
Color Opacity Name A
1.00 Solid

ﬂ[:-iﬂ-

1.00 Ventricles

v Dlsplay
Overall visibility: v
Visibility Opacity
Slice fill: v 050 <
Slice outline: 1.00 <
3D: v 1.00 «
» Advanced

~ Representations
Binary labelmap

«" Closed surface Update . Make master
Fractional labelmap = Create _

Select the Operation Export
» Copylmove segments and the Outuput type to
~ Export/import models and labelmaps Labelmap tO export the

Operation: e Export Import
Output type: e Labelmap Models Seg me nta tl on to a hew
Output node: Export to new labelmap -
» Advanced labelmap
Export
» Export to files
» Data Probe: /Users/spujol/Dropbox/or...2019-01-12-Scene.mrml ol Cl |Ck O n Export
Puji



Part 3: Fiber
Tracking in

peritumoral area
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@ @ @ Modules: i Data -

All Modules »
£ Annotations
(.D )Slicer & Data
= 4 . DataStore
£ DICOM

» Help & Acknowledgement
Markups

Subject hierarchy | Transform h & Models
% Scene Views

Node ’
§ BaselineVolume # Segment Editor
@ DTIVolume @ Segmentations
~ % Segmentation & Transforms
@ g():stlc-Dllated I View Controllers
D lid .
@ Ventricles S Volume Rendering
~ | Segmentation-models @& Volumes
@ Solid &3 Welcome to Slicer
© Cystic Wizards b
@ Ventricles

© FiberBundle informatice ’

Clogismton N

Segmentation »
Quantification »
Filtering »
Surface Models »
Converters »
Endoscopy »
Utilities N
Developer Tools »
Legacy »
Testing »
MultiVolume Support »

v Show transforms  Show MRML ID's

» Subject hierarchy item information
Filter:

» MRML node information

» Data Probe: /Users/spujol/Dropbox/or...2019-01-12-Scene.mrml

t- B R B

Tractography Seedmg

+EREE LN

L I

_ ! Select the module
e B Tractography Seeding

Oantifv = L 0= . from the Diffusion
Uiites : Tractography section
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Tractography Seedmg

@ @ Modules: 4% Tractography Seeding v | G 0 : ok o % -~ B A *6 .

® 01
[ Slic
‘ . er

» Help & Acknowledgement

5S: 56.141mm

- Select the Input DTl volume DTIVolume
e Set the Output Fiber Bundle to Create New Fiber Bundle As

Output Fiber Bundle Peritumoral_Fibers_F : and name It Peritumoral_l:ibers
- Seeing Set the Input Label Map to Segmentation-label

Seeding Label Value 1 - R: -11.598mm

Input Fiducials, Model or Label Map Segmentation-label v

Seed Spacing (mm) e 200 =

. - » # -
Use Index Space v R
Random Grid .

Update
~ Tractography Parameters
Threshold Type Fractional Anisotropy

Seeding Threshold e== 0.15 =
Stopping Threshold e 0.25 s
Integration Step Length (mm) = 0.500mm <

» Advanced Options

» Data Probe: /Users/spujol/Dropbox/or...2019-01-12-Scene.mrml
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Tractography Seedmg

@ @ Modules: Tractography Seeding v | - \) ‘) , % -~ B fa i .

2 BB
B 5r
Slicer
= 4
» Help & Acknowledgement

Slicer generates the peritumoral fibers

» Parameters Node
~ 10

Input DTI Volume DTIVolume v
Output Fiber Bundle Peritumoral_Fibers v
~ Seeding
Input Fiducials, Model or Label Map Segmentation-label v
Seeding Label Value 1
Seed Spacing (mm) e 200 =

Use Index Space v
Random Grid

Update
~ Tractography Parameters
Threshold Type Fractional Anisotropy v

Seeding Threshold e= 0.15 H
Stopping Threshold e 0.25 s
Integration Step Length (mm) = 0.500mm <

» Advanced Options

The fibers are color-coded according
to Fractional Anisotropy (FA) values
(red = low FA, blue = high FA)

» Data Probe: /Users/spujol/Dropbox/or...2019-



Interactive Tractography

@ @ Modules: # Tractography Seeding v || - \) ‘) e . e B 4 5 -

5 & t‘1 T {mm
~— ,i% Click on the Arrow to posmon a fiducial
ot near the tumor

» Help & Acknowledgement

» Parameters Node
~ 10
Input DTI Volume DTIVolume

Output Fiber Bundle newFiberBundle_Segmentation-label - |n the |O SeCtIOﬂ, Set the OUtpUt Fiber Bundle to Create
BT New Fiber Bundle As and name it New_FiberBundle
b et In the Seeding section, set the Fiducials to F

]

Fiducial Region Size (mm) = 2.50
Fiducial Seeding Step Size === 1.00 |3
Max Number of Seeds 100 =

Seed Selected Fiducials Only
v Update (check for interactive)

~ Trac phy Parameters
shold Type Fractional Anisotropy v

Seeding Tt

sompngr CNECK the box next to Update to turn on
megration StepLeng. the jnteractive mode

» Advanced Options

» Data Probe: /Users/spujol/Dropbox/or...2019-01-12-Scene.mrml
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@ @ Modules: 4% Tractography Seeding

@ Slicer

» Help & Acknowledgement

» Parameters Node
~ 10
Input DTI Volume DTIVolume
Output Fiber Bundle newFiberBundle
~ Seeding
Input Fiducials, Model or Label Map F
Fiducial Region Size (mm) =
Fiducial Seeding Step Size ===

Max Number of Seeds 100
Seed Selected Fiducials Only
v Update (check for interactive)

~ Tractography Parameters
Threshold Type Fractional Anisotropy
Seeding Threshold e=
Stopping Threshold e
Integration Step Length (mm) =

» Advanced Options

2.50
1.00

0.15
0.25
0.500mm

» Data Probe: /Users/spujol/Dropbox/or...2019-01-12-Scene.mrml

Interachve Tractography

B 2 S

Set the DTl volume in Foreground and fade
between Background and Foreground

S.Pujol R.Kikinis - All Rights

ed 2011-2019
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R = I $: 71.741mm
« @ % - Axial

m Y P
Segmentation ~
Segmentation-label
DTIVolume

BaselineVolume

R: -11.598mm

3 4

All



@ @ Modules:
@ Slicer

» Help & Acknowledgement

» Parameters Node
~ 10
Input DTI Volume DTIVolume
Output Fiber Bundle newFiberBundle
~ Seeding
Input Fiducials, Model or Label Map F
Fiducial Region Size (mm) =
Fiducial Seeding Step Size ===

Max Number of Seeds 100
Seed Selected Fiducials Only

4% Tractography Seeding

2.50
1.00

v Update (check for interactive)

~ Tractography Parameters

Threshold Type Fractional Anisotropy

Seeding Threshold e=
Stopping Threshold e
Integration Step Length (mm) =

» Advanced Options

0.15
0.25
0.500mm

» Data Probe: /Users/spujol/Dropbox/or...2019-01-12-Scene.mrml

J X

=1

o,

t

-

Interactive Tractograp

- =0 Q.

5] {-).'.'

Move the fiducial F1 in the 3D scene
to display the tracts in the ipsilateral

and contralateral side
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Segmentation ~
Segmentation-label
DTIVolume

BaselineVolume

R: -11.598mm

All



Interachve Tractography

B2 B &3 Modules: -—OC) ) Bl t- B @ 5 -

4% Tractography Display

3 X

B sosice: Select the module Tractography Display
=4

» Help & Acknowledgement

Turn the Peritumoral_Fibers and newFiberBundle
visibility mode to Tubes

~ Simple Display

Name Lines TubeeS Slice Glyphs Tubes

Solid Tube Color

Peritumoral_Fibers ”» - >
newFiberBundle - ‘, D . =
Percentage of Fibers Shown 100% -

» Fiber Bundle Selection
» Advanced Display

el 8

Move the fiducial in the 3D scene to
explore the white matter architecture on
the contralateral side

» Data Probe: /Users/spujol/Dropbox/or...2019-01-12-Scene.mrml S PUiol R Kikini
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F3 '

R: -11.598mm

A: 14.278mm



Summary

* 3D Slicer enables interactive exploration of
white matter fibers in the vicinity of a tumor:

— The Segment Editor module provides tools for
building 3D models of the tumoral region

— The SlicerDMRI solution enables 3D interactive
reconstruction of white matter fibers in the
peripheral region
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